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General

Although the content and layout of all Alastri applications vary considerably, there are a number of common
elements that are present in all programs, or are repeated in most of them. These elements are called
"Common User Interface Elements" and can range from individual buttons and tabs to the entire panels and
views.

The main reoccurring in all of Alastri's applications items are shown in the figure below, but these are not all
common Ul elements. For a complete list, see the sections below.

Before starting work with the applications, it is recommended to familiarize yourself with the content of the
current document.

2 Current app tabs Embedded appstabs | —
File Tools Help Ten Toolba
op Toolbar

Setwp | Databace | Schedule |@ Houl Infinty | [ Rapid Reserver | Plan selection compass
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Setup Tasks panel

On the left side of all Alastri's applications is the Setup Task panel, which represents a list of all the project
setup steps that need to be completed before switching to the scheduling, network and reserves
calculation tabs.

Setup Task
@ Configuration Options -
@ Extension Source
@ Extension Parameters
@ Production Mode Features
&) site Lists
- [\ Datzbase
&) Tables
@ Parcels
@ Fields
&) Primary Fields
&) Processing Paths
& Data Sources
ﬁ Map Tables
ﬁ Map Data
e Initial Database
ﬁ. Database Refinements
ﬁ Refined Database
ﬁ Record Removal
e Preschedule
ﬁ. Prescheduled Database
ﬁ Database Corruptor
ﬁ Corrupted Database
& Unblasted Blocks
e Parcel Subszets
ﬁl Record Subsets
ﬁ Mutex Record Subsets
- ﬁ Scheduling -

When setting up a project for the first time, all setup tasks need to be performed in the specified
sequence. You cannot proceed to the red marked step without confirming the previous one. During the
subsequent work with the configured project, you can return to any of the steps, but after making
changes you will need to rerun all the tasks below in the list. This is because changes you make in a single
step can affect settings in related tasks and need to be reviewed or adjusted.

e Completed and confirmed setup steps are marked with a check mark. You can return to
such steps at any time and in any sequence.

e Steps in the course of which an error has been made are marked with a triangle. Read its
description at the bottom of the screen and solve it to proceed to the next steps.

e  QOutstanding steps that need to be completed in order to continue with the project setup and
enable the remaining steps and tabs are marked with a red circle.
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e  Steps that are currently being worked on are marked with an empty circle.

You cannot change the order in which setup steps are listed in the Setup Task tab, but you can customize
their visual presentation by changing the color and font of the text of the step name, or by disabling some
(or all) steps from being changed. This feature is called "Configure Roles" and is described below.

Configure Roles

Configure Roles function allows users to customize the Setup Task list. It is used to facilitate the view of
the Setup sequence by highlighting priority steps in color and font, or disabling uneditable ones. This can
be useful to help guide newer users to the important steps that need to be reviewed and updated each
planning cycle.

| B W
z =Default= - | | &3 [ (9]
Setup Task

e To create a new Role click on the gear icon. Configure Roles dialog will open, where you can
create new roles and view existing.

= <Default= -

e Use dropdown menu to swap between Roles.

= =Default= B izh
= Default>
<[Disabled =
Two Week Plan

Configure New Role

To facilitate working with your project several options are available for configuring Role layouts.

= =Default= g 7

Press the gear button to open Configure Roles dialog.
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Configure Roles =]

= Name Disabled ForeColor Bold Italics
W@ H =
; 3 Configuration Options = -
R
e Extension Source M

<Default> Extension Parameters ¥
<Disabled>

& i Twh Week Plan

Extension Data Sources

Production Mode Features
Site Lists
~ Database
Tables

A&

Parcels

Fields

Primary Fields
Processing Paths

Data Sources

Map Tables

Map Data

Initial Database
Database Refinements
Refined Database

NEONNNEE

<l

Record Removal

Preschedule

Prescheduled Database

Database Corruptor

Corrupted Database

Unblasted Blocks

Parcel Subsets

Record Subsets

Mutex Record Subsets
~ Scheduling

NEE

Periods

8 cancel ||of ok

Configure Roles dialog items and their usage

Option Name Purpose

Name Name of the step being edited
Disabled Locks step from being altered
ForeColor Changes text

Bold Changes test to bold

Italics Changes test to italics

Press OK and view the applied changes in the Setup Task list, as shown below.
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| @ Two Week Plan - | |§| |E|

Setup Task

@ Configuration Options
@ Extension Source
@ Extension Parameters
@ Extension Data Sources
&) Production Mode Features
&) site Lists
-+ &) Database
& Tables
@ rarcels
& Ficlds
€ Primary Fields
@ Processing Paths
@ Data Sources
€ Map Tables
@ Map Data
& Initial Database
&) Database Refinements
& Refined Database
@ Record Removwal
&) Preschedule
& Prescheduled Database
@ Database Corruptor
&) Unblasted Blocks
& Parcel subsets
& Record Subsets
& Mutex Record Subsets
- &) scheduling
&) Periods
& Period Subsets
& Guidance Categories
& Guidance Schedules
€ roint Solids
@ Dumps
€ swel Factors
&) Stockpile Chunks

Fo- 1 1

[ ]

ERDREDR

B @

Steps can only be Locked for editing. They cannot be removed from the list.
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Notes Panel

To the right of Roles selection and configuration buttons one more button, Show Notes Panel, provided.

| = Two Weeks Plan

-

Setup Task

| @(F)
Lag

@ Extension Source
& Extension Parameters
& Production Mode Features
&) site Lists
@ Database
& Tables &

Parcels &
@

When you click this button, the Notes panel appears on the right side of the screen, where you can write
notes for each setup step, whether locked or available for editing.

setup | Datobase | Schedule | [ Houl nfnty | [Rapid Reserver |

Notes

— — = == iz e =
? st Type @0 [¢/v W24 0D &
[4 [ V) vejlva] (U] &
Dumps
— = Name
F - stockpik
= J|e22] St“k"fles" e » | DeadCoarseOreStackpie
ockpile Mutex Groups
Setup Task v " LiveCoarseOrestockpile
Crushers
(@ Configuration Options a - LongTermi
@ Truck Types
Extension Source LongTerm2
@ Extension Parameters Loader Types MoB1
(@ Production Mode Features Loaders Mom2
@ site Lists =) Other Equipment Voms
- (&) Database Plant Components oma
Products
g TEHEIS @ MOBFinesProduct
Pareels o MOBLUmpProduct
@ Fields a
ROM1
@ Primary Fields I} .
&) Processing Paths a "
&) Data sources ROM3
@ Map Tables a ROM4
(@ Map Data ROMS
@ mitial Database ROME
(& Database Refinements ROM7
@ Refined Database StockyardrinesRegular
&) record Removal StockyardFinesSpecial
&) Preschedule StockyardLumpRegular
(@ Prescheduled Database StockyardLumpSpecial
(@ Database Carruptor
& Corrupted Database
&) Unblasted Blocks
&) Parcel Subsets
& Record Subsets
@ Mutex Record Subsets
« @ Scheduling
(&) perind -

You can add Notes here:

You can also add pictures (screenshots) to your Notes.
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To hide the Notes panel, click the cross in the upper right corner. This will not delete the entered notes,
but will close the panel and move it back to the left side of the screen as a folder sign.

File Tools Help
setp | Database | schedue | [ Haul ity | [ Rapd Reserver
- —— ————— Notes
‘\E}‘ B> b =tV @0 +/[¢] 5 (0@ (2|
Dumps You can add Notes here:
G Two weeks Plan i b | DeadCoarseOreStockpile o
Setup Task Stockplle Hutes Groups LiveCoarseOrestockpie R
(@ Configuration Options - Crushers LongTerm1
(@ Extension Source Truck Types LongTermz
@ Evienson parameters Loader Types woet
(@ Production Mode Features Loaders MoB2
@ steusts = Other Equipment oes
-+ (@ Database Plant Components MoEa
@ Tables a Products MOBFnesProduct
@ parces o MOBLumpProduct
@ Fields a
@ Primary Fields 8 RoML
& Processing Paths a RomM2
(& Data sources ROM3
@ Map Tables a ROMS
(& MapData ROMS
@ Initial Database ROM§
(@ Database Refinements ROM7
(&) Refined Database StockyardFinesReguiar
@ Record Removal StockyardFinesSpecial
@ Preschedule StockyardLumpRegular
(& Prescheduled Database StockyardLumpSpecial
@ Database Corruptor
@ Ctormupted Datebase
& Unblasted Blocks
(@ Parcel Subsets
@ Record Subsets
& Mutex Record Subsets
+ @ scheduling
(&) perind: s

A mini Note icon will be shown beside the setup task step if the setup task includes a note.

Setup | Datebase | Schedule | []Haul nfinty |

o= . — — o) (a2 =] (o Hotes -
&\ vl » 2= 9o [+ @ K @@ @
— Dumps o You can add Notes here,
@ < - =[] || stockntes » | LiveCoarseOreStockpile
Setup Task stockpile Mutex Groups Longremms L
& Configuration Options - Crushers LongTerm2
(@) Extension Source Truck Types MOBFinesPr
(@) Extension Parameters Loader Types L
(& Extension Dats Sources Loaders R
@ Production Mode Features Oth, aom3
@ siteLists @." Plant Components e
- (@ Database Products
ROMS
&) Tables
ROMS
& Parcels
) ROM7
© e StockyardFinesRegul
@ Primary Fields yardFinzsRegular
@ Processing Paths StockyardLumpRegular
(& Data sources
(&) Map Tables
& Map Data

@ mitial Database

(&) Database Refinements

(& Refined Database

(& Record Removal

(& Preschedule

(&) Prescheduled Database

(& Database Corruptor

(& Unblasted Blocks

& Parcel Subsets

& Record Subsets

& Mutex Record Subsets
- (@ Scheduling

(& Periods

& Period Subsets

& Guidance Categories

(& Guidance Schedules -
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Setup Tasks Run buttons

The blue play/run buttons at the top left of all Alastri applications, above the Setup Task list, are used to
confirm that the project setup steps have been completed correctly and to run them to proceed to the
next task or Scheduling/Database tabs.

2 1
= =Default> - | | €23 || [
Setup Task

@ Configuration Options -

@ Extension Source
@ Extension Parameters
@ Extension Data Sources
(&) Production Mode Features
(&) site Lists
v Database
(&) Tables
(&) Parcels
&) Fields
(&) Primary Fields
(&) Processing Paths
Data Sources

ﬁ Map Tables

Button Usage

Re-Run Current button. Used to re-run the current step, for example, after making
changes.

If the data in the step is populated correctly, it will be confirmed - marked with a
green ticks, but you will stay on that step.

Run Next button. Used to confirm the current step and proceed to the next one.

If the data in the step is populated correctly, it will be confirmed - marked with a
. green ticks and you will automatically move on to the next setup step.

If you have filled in the step incorrectly, it will be marked with a triangle and
you will not be able to proceed to the next step until you have corrected the errors.

Run All button. Used to confirm and run all the setup tasks.

W If all steps are completed correctly, they will be marked with green ticks and you will
be able to move to other tabs of the project.
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Periods and Scenarios Run buttons

Scheduling software (Production Scheduler and Tactical Scheduler) that have a Schedule tab also have a
panel of buttons for confirming and running individual periods and scenarios.

Setup | Database | Schedule m-iaul Infinity

Scenarios ! |

2019 Dec 29
06:00:00

2l Ll &>

Scenario Mode
<& Mining

Andillary

3 Everything

Ry [ -

Button Usage

Run Period button. Used to run a single period within a selected scenario.
Periods are run in order. You can also use the F9 key to run periods.
When running the periods, the bar of the corresponding scenario will be proportionally

colored green, and when changes are made to one of the periods, the scenario will be
displayed in until it is run again.

Run Current Scenario button. Used to run the currently selected scenario.

. I All periods will run and the scenario bar will turn green. If you make changes to any of the
L,..gf.f periods - the scenario will be displayed in until it is run again.

You can also use the F10 key to run current scenario.

Run All button. Used to run all scenarios.

L"f}} All periods will run and the scenario bar will turn green. If changes are made to any of the
periods - the scenario will be displayed in until it is run again.
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Help button

All Alastri applications have two help buttons, shown in the image below.

File Tools @

Setup Reserves l Schedule Mot Configured

o || P b

2 <Default> - || k| |9

Click the Help button in the top bar to access the documentation section for the application used
("Documentation" option), see the amount of RAM it’s using, and read version and copyright information
("About" option).

| Help |

] Documentation
Memory: 1,801 MB
& About

Click the Help button (blue question mark) to get detailed information on the current setup task - you will
be automatically redirected to the relevant documentation page.

>
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Tree Structure and Viewport

The Alastri software uses a tree-structured hierarchy of level records (on the left) to display an organized
list of items. Interaction with records from this list is done in the 3D viewport area (the main area in the
middle of the screen).

Setup | Database | Schedule Haul Infinity | Rapid Reserver | Viewport
Records Tree Structure r il Visibility Mode = | @ Labels - [T} & £ Q (| # @ | [E-

Record Subset: <All Re\ fo - @ @

Reserves #0 =
- [ M1E0
~ @ W PL20
~ [ WP P101 %0

v [ & 770 #770

v [ & 760 £760

v [] & 750 #750

v [ S 740 £740

v [ B 730 #730

v [ 720 #8720

v [ & 710 #710

v [ B 700 #£700

- i W P102 £0

v W B 820 #5820

» b O 810 #8310

v W TP 800 #5800

+ b B 790 #790

v W B 780 #780

v i W 770 #770

v+ ] " 760 #7860

» i B 750 #750

v W B 740 #7940

v ] = 730 #730

» W B 720 2720

v i 710 #710

» W & 700 £700

» W TP 690 #630

» Y O 680 680

v W TP 670 #670

+ b B 660 650

v W TP 650 #650

+ b O 640 #5640

» [ W P2#0 161 fps | 6.200 ms /T NVIDIA Corporation GeForce GTX

~ [ WP P201 %0

(4630.3, 954.3, 790.0) @

4

Levels Tree Structure

A tree structure (or hierarchy) of levels/records is a list of all levels, arranged by parent and child records.
In applications from Alastri, such a structure displays a hierarchy of mine parts, as following:

e Reserves - Mine - Pit - Phase - Bench - Blast - Flitch - Solid, and
e Dumps - Dump - Lift - Solid.

The levels/solids selected in the tree structure will be displayed in in the viewport.
Terminology
o A “checked” record is ticked in the record tree, and glows yellow in the viewport.

e A “focused” record is highlighted in the record tree, and displays normally in the viewport.
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e A “selected” record has been left-clicked with the mouse. Depending on context, this may refer
to either checked or focused records.

Checked

record =
- P1#0
W P101 20 |
v | | WP P102 %1
' W r2x1 |

» [ WP P3#2 \\

« [ ] & Dumps £1
[7] M Dump1 %0 Focused record

[ ] & Dump2 #1
[] & Dump3 #2
[ 16123
+ [ & Backfils #2
[] W Pit1 #0
[] W Pitz =1

-

-

-

-

-

-

Interacting with the tree structure

1. Expand the hierarchy to the desired level by clicking on the arrows/triangles.

Vo v [T T—

Latenad S PNl ¢ e -

toee
133334

3
T ETEEE T
. ;&

b

2 2232222222202

¥
[
I
i

2. To select a record, tick its box by left-clicking on it. Similarly, to deselect it.
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3. Double click a record to center it in the viewport.

4. You can select an entire level, such as a Pit or Stage, by clicking on it - all its items will be checked.
Similarly, to uncheck.

5. You can select individual solids as well as multiple. To do that use the <CTRL> and <SHIFT> keys.
Viewport
The levels/solids selected in the tree structure will be displayed in in the viewport.

You can also select the solids manually in the viewport. For that left-click on the necessary block. Use
<CTRL> to select multiple, or box select the group of solids or entire object.

@ Visibility Mode v | @ Labels + |{7]

$¢QH H = E

&7

(1654.8, 1579.8, 790.0) @

You can interact with the objects displayed in the viewport using the tools on the top toolbar and change
their angle view through the compass icon or the mouse control buttons. More information on navigating
and control see in the Toolbar section below.

When you hover your mouse over any element in the viewport, the status bar in the bottom panel

displays information about it, namely the coordinates of the mouse cursor and the full name of the entry
(if applicable).
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Toolbar

In the setup steps and scheduling tabs, where you work with 3D blocks of Reserves and Dumps, haulage
network and animated Calendar, above the viewport there is a toolbar. Depending on the functionality, it
can be either small, containing mainly only navigation buttons, or extended with additional more complex
planning tools.

Navigation Elements

See below a description of the main navigation elements found in all of Alastri's applications. Use these
tools to see and interact with the 3D design area.

Mouse Controls

Select i Left click and drag

Pan + Middle click and drag
Rotate CI?T‘J Right click and drag
Zoom Q Scroll wheel

Zoom to All |E| Left click to Zoom to all

. . <CTRL> + Scroll wheel
Vertical Exaggeration -

Compass

Plan View Y Click on the axis cones to snap to orthogonal views

4
8 «x

Night Mode ‘. Click on the sun icon to toggle night mode, and back

Zoom Extents Click on the grey cube icon to zoom to extents

In Haul Infinity, the compass icon is different than used in other apps but performs the same functions.
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e  Click on the sides of the compass cube to quickly change to Right, Left, Front, Back, and Bottom
views.
e Youcan also use the N (north), S (south), W (west), and E (east) symbols to change the view.

Measurement
Display a grid in the viewport.

Grid H Note that the grid is only displayed in the top view. If the grid is
not displayed, then you are working in a different plane. Press
the "Z" icon on the compass to return to the top view.

Ruler [ Draw a measurable distance in the viewport

Scale : 0020200 _s0 500 Scaling shown at a bottom of a viewport

Screenshots

Most control panels also include a screenshot button used to save the viewport capture in a suitable
resolution for later reference in reports or presentations.

[ ] ~ |
1x Resclution
2x Resclution
5% Resclution
1920 10280
3840 2160

1. Open the resolutions options list by clicking on the screenshot button dropdown in the top
toolbar.

2. Select an appropriate resolution (this action copies the image to the clipboard).

3. Paste the image in another document.

Note that in Haul Infinity, the screenshot feature is also present and serves the same purpose, but
represented by a different icon, as shown below.

e ] =
1x Resolution
v Resolution

3x Resolution
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Visibility Mode and Labels buttons

Some toolbars (in Production Scheduler and Tactical Scheduler) also have Visibility Mode and Labels
buttons.

B Visibility Mode - @ Labels -

The Visibility Mode button is used to select the components to be displayed in the viewport. From its
dropdown list you can choose:

e “View Selected” - only selected components will be shown in the viewport. It is used to facilitate
viewing..
e "View All" - all objects will be displayed in the viewport. Used for overall view of all mine

components.

@l Visibility Mode |+

[ Wiew Selected
[ View Al

The Label Display button (may be named Labels or Label Display in different applications, or be
represented simply by an eye icon) is used to show or hide labels. In most applications, this button is
accompanied by a custom label setting function (the gear icon). For more details, see Shadings and Tags

section below.

Layers/Overlays panel

The Layers/Overlays panel is common to all Alastri software. Panel name Overlays is used only in Haul
Infinity, in other programs it’s named Layers.

Overview and location

The Layers/Overlays panel is present in the sections of all Alastri applications where you work with solids,
surfaces, haul networks, animations, reserves and dumps databases.

To use this panel, open the Layers or Overlays tab (in Haul Infinity only), which can be docked in the
viewing area, or minimized and hidden in the sidebar.

e Use the pin icon to dock and auto hide the panel.

Layers

ol =l A =R 18 ~ || Tools =
o/l il O )
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e Use the rectangle icon to maximize the panel area, or restore to the default/previous view.

Overlays % n Overlays
A, |lrn

L 5 v EHEIE
. : Restore

Maiximize

e Surfaces and solid triangulations can be imported into the software for display through this
panel. Points files may also be imported and triangulated.

o>
1
-
&
1

O @ ®
Name
¥4 pointsFie

~ G Dump Designs
QP dump2.3
@ dumpl.3
QP dump3.3

» 5 Pit Designs
@ pitl_s1
@ pitl_s2
P pit2
@ pit3

~ G Surveys
@ topo
@ preschedule

4

4

4

N

«

CNE
§ 4

)

9968800 BBNE 6
|8

RERXRRRRBIRRE B

| NNE
‘

Layers/Overlays panel items description

Icon Description

] Blue Plus icon to import files into the software.

% Create folder to organise files in the panel.

Delete file/folder. Highlight files to be deleted and select delete button. Using the <CTRL> or
<SHIFT> keys multiple files may be selected.

o
Only one folder can be deleted at one time to prevent deleting lots of data at one time.
g Show/Hide.
fl Lock or unlocked for editing.
& Show triangle edges.
L") Triangulated file (Surface/Solid).
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5 Points file.
Click on color dropdown to select triangulation colour and level of transparency, as well as
- - drape images over triangulations. More details see in the section Color and Drape Image
below.
Select options for sorting layers i
Sort Ascending
By name: :
12~ - Sort Ascending Sort Descending
- Sort Descending Sort by Layer Type
By Layer Type_: Sort Ascending
- Sort Ascending .
- Sort Descending Sort Descending

Supported Layers
The following file types are supported:

e  Vulcan v7-v10 (“.00t”)

e  Vulcan Arch_d File (“.arch_d")

e Surpac STR File (“.str”)

e Surpac DTM File (“.dtm”)

e  AutoCAD 2010-2013 DXF (“.dxf"”): Modern AutoCAD 2013 DXF and Legacy AutoCAD 2010 DXF.

e  CSV Points File (“.csv”)

e  MineSight MSR (“.msr”)

e Wavefront OBJ (“.obj”)

e Itis also possible to import and export Shapefiles (".shp”, “.shx”, “.dbf”) across all the
Layers/Overlays panels.

Creating Layers and Folders
In the Layers panel, you can import layers into a project and organize them into folders.

You can create several custom folders with subfolders (if desired) and rename them as needed to make
working with layers easier.

Layers n
(] = J:L% * || Tools =
Mame a @ J

+ |= PitDesigns @ i [

(= Pit1 ®» W]~

= Pit2 @ 5[] -

= DumpsDesigns ah  h jxjf -

= Solids & -

l= Surveys & x;,; -
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Moving Items

You can change the order in which folders and their items are displayed by dragging and dropping them.
The place of insertion is pointed by blue arrows.

Layers L
=i |42 ~ || Tooks ~ |
Mame @& &

+ | PitDesigns @ -

= Pit1
= Pit2
[= DumpsDesigns
(= Solids .
?@mm @ &

ANINNNNAN WY
4

N

Import Files

To add layers to the created folders or separately in the Layers panel use the blue plus icon. In the import
window that opens select the applicable files in supported formats.

& open *
“« v 4 < sauron » Shared » 11_Generic Data for Demos » Designs v ] 2 Search Designs
Organise v Mew folder f=z » [H e
*
" () Mame Date medified Type Size
@, OneDrive [] dump1.00t 18/10/2018 6:50 PM 00T File 27KE
—_ [7] dump2.00t 18/10/2018 6:50 PM 00T File 25 KB
= This PC [ durmp3.00t 18/10/2018 6:50 PM 00T File 23KB
B 3D Objects [ finalcut.00t 18/10/2018 6:47 PM 00T File 64,173 KB
I Desktop [ finalCut2.00t 6/07/2020 10:54 AM 00T File 328,422 KB
Documents [ 1g1.00t 22/10/2018 10:39 AM 00T File 22 KB
3 Downloads [ Pit1_Palygon.arch_d 6/07/2020 10:52 AM ARCH_D File 6 KB
D Music [ pit1_s1.00t 22/10/2018 11:35 AM 00T File 93KB
_ [ pit1_st.dtm 21/10/2019 3:21 PM DTM File 81KB
[&] Pictures . )
_ [ pitd_ststr 21/10/2019 3:21 PM 5TR File 32KB
B videos [ pit1_s2.00t 18/10/2018 6:50 PM 00T File 166 KB
‘= Local Disk (C) [ pit_v2.00t 6/07/2020 10:54 AM 00T File 1,703 KB
= Tera (D) [ pit2.00t 18/10/2018 6:50 PM 00T File 19KB
it3.00t 18/10/2018 6:50 PM 0OTFil 55 KB
|_j Metwork D B S =
W
File name: | "pit3.00t" "pit1_s1.00t" "pit1_s2.00t" "pit2.00t" v| |AII Supported Types (*.00t, *.arc V|
| Open | | Cancel |
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After you have confirmed the files to be imported, a dialog box will appear asking you to specify the
triangle count (Triangle Count column) and the decimation method (Decimation column).

Decimation Results | = |
Mame Triangle Count
pitl_s1 2,580
pitl_s2 4,664 | Mone }
pit2 1,373 | Mid
- Moderate
pit3 1525 | Extensive
|x Cancel ||.{7 0K |

The loaded layers will be now listed in the Layers panel, select them holding <SHIFT> or <CTRL> keys and
move them to the appropriate folder.

Layers I
EEIEY | 44 - || Toois ~ |
Mame @& 8
. sl Al
i~ e
® & 55
® % El
2 & me)

e sO 49 B 8O FERE R s =
1 . ¥ | Desigm - o x j O WR 40~ Tk
[ [ P— 0, *& o
' , e e e
IR -4 11, Generic Data for Demmos » Dessgns v & abh Dessge @ i ® & W-
- @ o s ® e
i & Domnicads # A Name Diste roa i Pepes MES &
| ! " dumg 100 207 Fe ) 9"‘ : -'
| Ehaus 4 | durpd 0t 307 Fie 2518 | 45 20 -
' APS saved fler 07 Fie 2308 N ®
I bhechs firalo 00 bl " g »
Demo £ finalCiat 00 f ' o
1 gt ' 3 Survers »
"
Pit) Pehygonanch d D Fie
& OseDine ] petaroie
& nase Pl sldtm
s PR s1st '
e I 0752 : \
8 Desirop a1 v200 ol
i Doty P2 T
& Downlseds pelite f
D M

v

Mitems 3 ema selected T34 KB
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Decimation

Some files, such as topographic survey files, are much larger files and may take longer to import. That is
why it is recommended to "downsample" the number of triangles in such files using the decimation
feature.

Decimation Results x
Mame Triangle Count Decimation
e — .................... Mlldl/\v\?
topo 51,154 | None

Mild
Moderate
Extensive

8 cancel q;,-’? 0K,

Decimation is a reduction of image size by decimal subsampling, which is used to minimize the image
quality and loading time. When the triangle count is low, the default setting is zero decimation (<None>).
When loading larger layers with more triangles, you may need to select another option of low (“Mild”),
medium (“Moderate”) or strong (“Extensive”) decimation to reduce the uploading and scheduling time.
Depending on the choice of the decimation level, the time of importing layers may increase.

Working with import results

After the function has been run you will be shown the results.
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Select Triangulations

Triangle Triangle

Name Count Count Volume Original Decmated  Use Decimated
(Original) (Dedmated) Difference (m?)

EOM_Survey 1,562,329 406,342 4,103 ] @ M

In this example you see:

e Name of the imported layer (the Name column) - here “End of Month Survey”.

e Triangle count: original (Triangle Count (Original) column) and reduced (Triangle Count
(Decimated) column).

e Volumetric difference between these two surfaces in cubic meters (which is, in this example,
relatively speaking is very small) in the Volume Difference column.
e  You can also display both surfaces or only toggle Original or Decimated.

e Enable or disable Use Decimation flag to determine which file you wish to use (Original or
Decimated).

It's recommended to rename a decimated file to make it easier identifiable. This decimated file size will
be much smaller so when performing solid operations the speed with which the functions perform should
be much improved due to the reduced number of triangles in this surface. This can be demonstrated by

exporting the decimated layer and comparing its size with original file size. To do this, press the Tools
button and select “Export Layer” option.
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Layers n
G_}y [@ 4 18~ IT00|SV
Name [ Export Layer
+ |=5 Pit Design Consolidate by
& pitl s Triangulate
&P pitl_s2 . |
i te
& pit2 ransla
&P pit3 Decimate
» = Dump Seq Report Velume
» |=5 Surveys
&P EOM_S Create Final Surface
& topo Collapse Al
v [= Solids
Expand All
m

You will see that the exported file will be five times smaller than the original one, which significantly

improves processing time, reduces the size of the final file, and makes the planning process more
efficient.

@
+ = dmeen o el o 19 Gesets Dite b Divi « Sty hd
Cirgiring = Pép= foider L ]
Frep— - Harea e -
P I O B Sy 00
1 Csitep T Sorory Derimmanid 10
[ Hanaicue 00
. 0
& Bowniosd e
B Wiz
& Puam
B s
T Looerad D C.
- T )
b Hemeprt
-
[ [ R wep—
St wk Dot Wishan ¥ 7-v 10 D0y (000
& iy Fkar

Tools available in Layers panel

Locate the Tools button in the top right corner of the Layers panel. It is used to perform various actions
with the imported layers. The options, available from its dropdown are described below.

Page 26 of 48



Layers b

FIEE - =]
| Name ‘ Export Layer
~ [ Pit Design Consolidate
P pit1_s1
P pitl_s2 :
P pit2 ranslate
@ pit3 Decimate
+ i Dump Seqy Report Volume
v =y Surveys
QP EOM_Si Create Final Surface
@ topo Collapse All
v =y Soids
Expand All

Export Layer

1. Export Single Layer. Select one layer you wish to export and in Save As window specify its name
and saving path.

2. Export Multiple layers. Use <CTRL> and <SHIFT> keys to select multiple layers you wish to export.
When exporting multiple, the program allows you to place them into zip file (folder icon in the
Export Location field). Specify applicable format for Construction Line, Solid and any Text what
you may have loaded as well. Available formats include “.arch_d”, “.str”, “.dxt”, “.obj”, “.shp”,

llOOtII.
Export Layers
Export Location =]
Construction Line File Format | Vulcan Arch_d File (*.arch_d) -
Solid File Format Vulcan w7-v 10 00t (*,00t) -
Text File Format Vulcan Arch_d File (*.arch_d) -
8 cancel ({? Ok
Consolidate

Allows to consolidate multiple layers into one. Choose layers required and select “Consolidate” option
from the Tools button dropdown. Selected files will be merged into one new generated layer, which
contains these consolidated items.
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Layers |

FIEIR 48~ |[Toos ] |

Mame Expart Layer
» = PitDesign Consclidate
W pit1s1 Triangulate Q’
pitl_s2
z mz_s Translate
P pit3 Decimate
- & g Report Volume
@ dumpi
P dump2 Create Final Surface
Collapse All
% Dump Design [Triangles Consolid
v = Surveys Expand All

Triangulate

Triangulation function is used to triangulate lines, available only when polylines file is imported, otherwise
greyed out.

Translate

Translation function is used to shift information in X, Y and Z-directions if you need a slight change or if
you wish to change grids. Translated files will be automatically added to the same folder where original
layer is stored.

Layers i |
IS 1 - |[Tools ~
Name Export Layer
+ | Pit Design Consolidate
& pitt s1 Triangulate
P pitl 52
&P pit2 Translate
P pit3 Decimate
+ |5 Dump Design Report Volume,
¥y dumpl
dump2 Create Final Sjfrface
& dump3 Collapse Al
Dump Design [Triangles Consolidated
dump1 [Translated] Expand Al
Translate Geometry [ x | i2 -
. v
X b -
=1l
¥ o M
z Ll
p v
|x Cancel ||@? OK |
LA -
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Decimate

The Decimation function automatically runs when a triangulated file is imported into the

software.

If you didn’t decimate a larger surface when importing it, you still can decimate it using
“Decimate” dropdown option. Select a file, choose the level of decimation required (including
<None>) and this function will retriangulate the given layer at a lower resolution. On completion
the results will be displayed, and the user has the option whether to use the original data or the

decimated.

Report Volume

Report Volume is an option to display total volumes of closed solids from layers in the Layers

panel.

Layers
AEIE
Mame
~ |=5 Pit Design
&P pit1_s1
P pitl_s2
&P pit2
&P pit3
+ |=r Dump Design
&P dump1
&P dump2
&P dump3
&P Dump Design [Triangles Consolidated
€9 dump1 [Translated]

1. Select layers you wish to report volumes of.
Press Tools button and select “Report Volume” option.

N

n
@5 v || Tools +
Export Layer

Consclidate

Translate
Decimate
Report Volume

Create Final Surface %

Collapse All
Expand All

3. Review Volume Report that opens, where you’ll see volumes of selected closed solids and

their Total.

Volume Report

Volume Repaort:

pitl_s1: 22,243,023 m3
pitl_s2: 39,392,009 m?3
pit2: 15,302,088 m?
pit3: 9,644,945 m3

Total: 86,532,125 m3

..................................

Page 29 of 48



Collapse All and Expand All

The last two dropdown options are used to collapse and to extend all folders. It is particularly useful when
working with larger projects with multiple layers, organised in many folders and subfolders.

Layers

EIEIEY

i s
[ 118~ || Tools =

MName

v [ Pit Design

+ [ Dump Design
v [ surveys

v (=5 Solids

Export Layer
Consolidate
Triangulate

Translate

Decimate

Report Volume
Create Final Surface
Collapse All

Expand All %

Layers

FIEIE

a
HL% '| Tools =

Final Surface Tool

MName

v = Pit Design
@P pit1_s1
P pit1_s2
P pit2
P pit3

+ = Dump Design
@ dumpi
&P dump2
&P dump3

€9 Dump Design [Triangles Consolidahedl

&P dump1 [Translated]

Export Layer
Consolidate
Triangulate
Translate
Decimate

Report Velume

Create Final 5urface

@9 dump2 [Translated]
@9 dump3 [Translated]
+ [= surveys
@ EOM_Survey
&P topo
+ [= Solids
&P topo
&P EOM_Survey
+ |4 DesignSurfaces
@ dumpl
@9 dump2
@@ dump3
P pit1_s1
P pitl_s?
@ pit2
P pit3
+ [ Solids
@ SolidPit1_s1
@ Solidritl_s2

Collapse All
Expand All
=
@& ’.v
@& ’.v
@& t.v
@& o -
@ :-'; v
o &M~
@ QM-
® R~
@ -
& QM-
o & M-
s QM-
& QM-
o M-
@ @H-
® R~
2 QM-
& W~ -

The Create Final Surface tool allows users to extract the lowest surface from any combination of solids
and surfaces. The result is coloured according to which solid or surface each part of the lowest surface
comes from. The tool can be accessed from the Layers panel, through Tools button dropdown > “Create
Final Surface” option, with at least one surface or solid selected.
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Layers 3

UL 42~ [Tooks ~
Name Export Layer
v & PitDesign Consolidate
@ pit1_s1
P pit1_s2
@ pit2 Translate
@ pit3 Decimate
v |y Dump Desig Report Volume
P dump1
QP dump2 Create Final Surface
@ dump3 Collapse All L
@ Dump D
& ) Expand All

A set of surfaces is generated and placed in a folder at the end of the process. One surface is generated for
each input that has anything in the end result, plus one more for vertical faces that are automatically
created to join any surfaces that touch when viewed from above.

Created surfaces will share the color settings and the names of their sources, allowing users to quickly
identify the input surface source for each part of the resultant surface.

S

Layers

-
1
-
&
]

0 &
Name
P pitl_s1
P pit1 _s2
P dump!
@ topo
v = Final Surface
P pitl st
@ nit1_s2
QP dumpl
@ topo

@ vertical Faces

4. -9

4

¢ 4 -4

‘<

90600668 8BY G

CREXRRERRE ®
EEN EOEE N

Result layers share the source surface’s colors and name, for quick identification.

From here, the user may use the results in one of several ways. With all the surfaces on, it is possible to
see a lowest surface created from all the inputs. An example of what this might represent is the
visualisation of end-of-period compliance, where one might see a combination of surveyed and designed
lowest surfaces. In this example, toggling off the surface generated by the topography might show any
regions which was planned to be extracted, but had not actually been reached in that period.
Contributions of individual dig blocks or pit solids can also be seen by enabling specific output surfaces and
the topography at the same time.
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Note that if two surfaces are very close to each other, the result may appear somewhat disjointed. An
example can be seen in the image below to the right, where the bottom surface of a dump solid is virtually
the same as the topography in the region where the dump solid exists. In the case of a pit solid’s bottom
surface, this result indicates that the extraction of material from the pit in reality is very close to the
designed pit.

Changing the colour and visibility for all the results can be done by changing the respective value on the
final surface folder. Combining the surfaces together into a single surface can also be done using Tools >
Consolidate.

The tool will handle intersections between any input surfaces and solids. If there are multiple surfaces that
would intersect at a given space, the lowest of all inputs is given in the result. An example is provided
below to illustrate this:

Input surfaces. Two pit solids intersecting in the End result. Note the yellow pit surface extending below
middle, and a dump solid below. Topography not the bottom of the purple, and the red/green surface
shown formed by the intersection of the topography and bottom

of the dump solid

“Create Final Surface” function is more orientated towards Spatial Conformetrics app.

Colors and Drape Image

Images may be set to a specific color, or draped to a triangulation by importing both the image and
associated georeference file.

Setting an image color
1. Select a layer in the Layers panel.

2. Click on the color selection dropdown to the right of the layer name . T
3. Click the Color tab.
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4. Click the

color selection button to display the color palette and opacity level.

1. Select the desired color and adjust its settings to your preference.

2. View the resulting color in the Sample field.

3. You can also enter numerical values for color hue (Hue), Saturation (Sat), Brightness
(Bright), Transparency (Opacity) or specify a color number in the palette (#).

4. Use the Make Web-Safe button to assign a web-safe color to the image.

5. Tick the Use Dynamic Lighting checkbox if you want to use dynamic lighting. But note
that this flag will cause the image to be of higher quality, which will slow down the
planning process.

6. Use the Line Width slider to adjust the thickness of the lines.

5. Press OK to finish.
Layers o
@ = % 42 - || Tools ~
Mame @ % L¥ )
’ = P finalcut @ @ ........
Color selector
T © Hue 243
O Bright 59.6
Opadity: 113
# 715A5093
Transparency indicator u
B Make Web-Safe
45%
Sample: [C] use Dynamic Lighting (Slower, Higher Quality)
Line Width: -:- Cancel oK
N

[2/SSEZ | OpenGl v4.6.0 NVIDIA 419.17

% - Data Reserves Legend Dumps Legend

Draping an image

ukhwn e

Select a layer

in the Layers panel.

Click on the color selection dropdown to the right of the layer name.

Switch to the

Drape Image tab.

Select Open Image and import the image file.
Select Load Points and import the georeference file.
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@l Visibility Mode ~ | 8 Labels ~ [T} b € Q [ # @ | [E- Layers i

ModelXCoord | Model Y Coord | 1ImageXCoord | Image Y Coord
-6030 5980 0 7000
5969 5980 7000 7000
-6030 -6015 0 0
Cancel Il oK
(29748, 2548.6, 841,1) finalcut (3~ || Data  Reserveslegend  Dumpslegend -

6. If required, adjust the image file draping settings over the triangulation in the coordinate table and
adjust the opacity with the Opacity slider.
a. Use the Line Width slider to adjust the thickness of the lines.

Color ~ Drape Image

Pont Moded X Coord Model ¥ Coord Image X Coord mage ¥ Coord

y 0 4 £0% " 0 000
P W %580 D00 000
Losd Pt 3 403 2018 ) 0
Sove Ponts
Opachy:
Lne o Cancel o=

7. You can also save the image points by clicking the Save Points button. In the dialog that opens, specify
the path to save the points file and its name. The exported file will be saved in the ".alsdrp" format.

A downsampled copy of the original image is saved in the working folder as “projectName.drapelmages”.
If this file is deleted, then all draped images are removed from the project.
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Supported Image File Types

You can import layers and surfaces files in the following formats:
e JPGFiles (.jpg)
e JPEG Files (.jpeg)
e  BMP Files (.bmp)
e  TIF Files (.tif)
e  GIF Files (.gif)
e PNG Files (.png)
Supported registration formats include the Vulcan IREG and the Surpac RGF.

Status Bar

The status bar display information for the current mouse location. It includes coordinates and the full
name of the level record. The information displayed changes as you move the mouse cursor.

(1449.4, 1643.4, 812.5) Reserves/M1,/P2/P201/210/4004/310/1 Mining_volume: 15,293

In the shown status bar you see:

1. Mouse coordinates - (1449.4, 1648.4, 812.5);
2. Record name - Reserves/M1/P2/P201/810/4004/810/1.
3. Label text - Mining Volume:16,298.

Manage Viewpoints button

~
Click Manage Viewpoints button @ to open the Viewpoints dialog, where you can add a new
viewpoint, delete one or few of them, move viewpoints up and down in the list, update, or take a

screenshot with the selected resolution.

0 OpenPit/Dumps/B.
1 Mine/Dump
6 2 Pitlift
3 Stage/Block
4 Bench
5 Blast
5 Block
- Misc
blastDelay
flitchList
fiitchIndex
blastFloor

drillSource

@0 ¢/v @ [=-
Name
Pit 1 view @
b Pit 2 view @
Dump 1 view @
[ 50400 450 200 250 300 350 400
e e e
133 1o 1 7.200 me 1 MVIDIA Corporatian GeFarce GTX 370M/PCIe/SSE2 | O]
(990.1, 1898.2, 814.5) ‘}'IE‘LEgend“—‘ 4
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Saved viewpoints can be useful for navigation and reporting.

Click the Manage Viewpoints button at the bottom right of the viewport.

Create a new view by clicking the blue plus icon and rename it according to the object displayed
in the viewport.

If you have more than one view, you can move them up and down in the list using the blue arrow
buttons.

To activate the selected view, click the green arrow icon. The active view will be highlighted in
green.

You can return to the viewport at any time and change the view/location of the object, and then
save the changes you made to the viewpoint by clicking the Update Viewpoint button (the up
arrowed sphere icon).

The Viewpoint window also includes a screenshot button with the selection of resolutions
available.

Note. In Haul Infinity, to manage viewpoints use the Views button.

Vocks= M@ Animation = }ﬁ‘l."iews "
Flags By Add View
o + ¥ Pits b
g_‘: Activate Dumps g

Stage 2 *
@ Rename

Data Panel

The Data panel is an area where data on the selected records are displayed and managed. It displays the
reserves information available at the current step.

Reserves are shown for all checked records.
If no records are checked, then reserves are shown for the focused record.
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You will find such a Data panel view in:

e  Production Scheduler: Setup tab > Initial Database step,

e  Production Scheduler: Setup tab > Refined Database step,

e  Production Scheduler: Setup tab > Prescheduled Database step,
e  Production Scheduler: Database tab,

e  Production Scheduler: Database tab > Animation tab,

e Tactical Scheduler > Setup tab > Preschedule step,

e Tactical Scheduler > Setup tab > Reserves step,

e Tactical Scheduler > Reserves tab,

e Tactical Scheduler > Schedule tab> Animation tab,

View Mode

In the top left corner of the Data panel is the Data View Mode button. It is used to change the current
data view mode, which affects the way the data is presented in the table below.

Data

|-

[ View Siblings in Columns

Hil  View Parcels in Columns

If a record is focused, the View Mode switches columns to show siblings or parcels.
o  “View Siblings in Columns” option - view shows multiple records at once.
o “View Parcels in Columns” option - view shows the activity breakdown within a record.

Activities

Switch between activities to see the quantities of work in each parcel. The database layout changes to
show fields that relate to the selected activity.
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Activity: ProductionDriling ~| |

")

4

StUC Activity
FU productionDrilin
EﬂIMin ing
m:i §
Mine /Dump M1 M1 M1
Pit/Lift Pl P1 P1
Stage/Solid P102 P102 P102
Bench 820 810 800
Blast
Flitch
Dig
~ BlastSolid
blastCode
blastType
volume m? 2,768,797 2,647,508 2,5
perimeter m 13,981 13,677
surfaceArea m? 289,742 274,161 2
wallLength m 0 0
= ProductionDriling
meters 0
holes 0
volume 0
0
0

&,

%

tonnes
rate

powderfactor 0.00 0.00 -
4 b

Data I Reserves Legend Dumps Legend Layers

oo o oo

Activity types are configured in Setup > Production Mode Features (in Production Scheduler).

Parcel Subsets

In the Parcel Subset field dropdown choose which parcels are shown for the current activity.
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~ | | Parcel Subset: <All Parcels>

Parcels are configured through the imported file in Rapid Reserver > Block Model and through Setup >

~ Struch

Parcel Subset

~ Levels <All Parcels>

Ore
Waste
None

n s WwN = O

other
Haulage\Ore

blo{ Haulage\Waste
blaj oreWaste\ore
bl oreWaste\waste
dat bg
hg
hgha
wal hohs
pre
har minw
digh w

Parcels (in Production Scheduler).

Exports

Option to export the database to external archive files.

Data

Activity: Mining

= 1R

Parcel Subset: <All Items>

-

~ Structure
Full Name
UID
Remaining

Legend

The Legend button, which is displayed in the bottom Control Panel (in ATS in this example), is used solely
to display the specified Reserves and Dumps shadings or Blast shadings and hatchings, and has no editing

function.

Reser

Export to CSV - Mining Data
Export to ZIP - 3D Solids
Export to ZIP - 2D Silhouettes
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Reserves Legend Dumps Legend
B 2019/Q1/1an/wo1 B 2023g1
2019/Q1/Jan/ w02 2023/Q2
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2019/Q1/Jan/ W04 2023/Q4
2019/Q1/1an W05 B 202401
2019/Q1/Feb 2024/Q2
2019/Q1/Mar B 202403
2019/Q2/Apr 2024/Q4
O ACH T M=
2 4

| —! Legend j

In other tabs and applications, the color legend can be featured by separate tabs with the function to edit
and create new shadings for individual elements. More details on custom shadings see in the section
Shadings and Tags below.

Shadings and Tags

In all of the Alastri applications, the user has a power to assign the desired colors and labels to project
elements. For some items, advanced custom labelling or color shading options are available.

Labels

Labels are symbolic names of project elements (dig and blast solids or entire levels of pits and dumps, as
well as routes and nodes for haulage, or agents, transactions, and activities), used as an identifier for more
convenient indication of data and properties.

In some parts of applications, the user has a choice to not only display or hide the labels of various project

components, but also to create custom labels. Such functions are usually accompanied by a dropdown
and/or a gear icon.
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For example, in the Reserves tab of the Tactical Scheduler there is a Label Display button located in the
top toolbar, which you can use to display or hide labels, select the color and font of text and background,
adjust the offset and overlap of labels used.

E;. Label Display | = I

Label Display Settings ]
Visibility Invisible

Fore Color [ ~ | Back Color -
LegendFaont | Tahoma - 3 o
Alignment Offset

Cwverlap Mo Overlap

There is no such button in Rapid Reserver, but labels configuration is made similarly through the Display
panel of Designer tab.

Label=
Labels | ¢
Text - ﬁ}
Back Color ~ Fore Color | ~
Font Tahoma v Size 8

-

Depending on user preferences and to make the project easier to work with, different information
applicable to a given view or scheduling task can be displayed in the custom labels. In some applications,
the available labels can be selected from a dropdown list of preconfigured tags, or you can create
personalized custom names through formulas in the Configure Labels window.

ILaI:IeI: <Record Name> - '1-3-:"
Clear
Label
<Record Hame> "

Structure_FullMame
[
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In Haul Infinity, custom labels are configured through Network > Display > Labels, where user can specify
the label text and its properties such as color, size and position.

Use the bulb icon to show or hide labels in the viewport.
Shadings

Shadings are an important part of the user interface and can be used to simplify viewing of the different
elements in your project. It is also easily configurable in all Alastri applications. The Production Scheduler
and Tactical Scheduler applications have separate tabs and fields with a gear icon that opens a window for
configuring colors and their gradients.

Let's look at an example of custom shading configuration in Alastri's Tactical Scheduler, where these fields
are placed in the top toolbar of the Reserves tab.

o
<
I I 1

ceqeacee!
Tt
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1. Click on the gear icon in the Reserves or Dumps Shadings field. The Configure Shadings dialog will
appear.

2. Press the blue plus icon to add a new shading and name it adequately.

From the Shading Field dropdown select a parameter you wish to configure shading for.

4. Specify the relevant colors, values and ranges.

w

a. Optionally click the Generate Gradient button to create color gradient.

b. Press the Create by Equal Counts button and set the applicable number of intervals - ranges
will contain an equal number of items.

c. Press the Create by Equal Intervals button and set the applicable number of intervals -
ranges will be equally divided by based on the highest and lowest values.

d. Press OK to confirm and return to the viewport to see the results.

Shadings configuration in Production Scheduler and Rapid Reserver is done similarly (via the Reserves and
Dumps Legends tabs in Production Scheduler and the Display panel in Rapid Reserver).

In the other applications (Haul Infinity and Spatial Conformetrics), these advanced shadings are not
available, but you can still assign the desired colors to items through the Color button dropdown, as
shown below.

o Hoe 102
Sat 100.0
Srght 100.0

Opaoty: 255

&  EFFO0

1. Click the color selection button to display the color palette and opacity level.

Select the desired color and adjust its settings to your preference.

b. View the resulting color in the Sample field.
You can also enter numerical values for color hue (Hue), Saturation (Sat), Brightness (Bright),
Transparency (Opacity) or specify a color number in the palette (#).

d. Use the Make Web-Safe button to assign a web-safe color to the image.

Q

2. Press OK to finish.
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Import and Export

Most of the steps and tabs in Alastri software have buttons for importing data from external files and
exporting to the appropriate formats and folders.

Import

To import files or layers (in the Layers panel), click the folder icon and in the Open window that appears,
specify the path to the file you want to add to the project in the appropriate format.

The import icons used in Alastri software:

J Used for importing files
T
@ Used to add layers and surfaces in the Layers/Overlays panel

Also, for all setup steps in the Setup tab, you can right-click on any task and select the "Import from File"
option, to import settings for an entire setup task.

Setup Task
&) Configuration Options -

& Extension Source
& Extension Parameters
& Productjop Mnde Feahiwree |
&P Site Lists | 2 this
. Database Export to File
& Tablef
&) Parcel
&P Fields

Export

Project setup tasks, reserves and dumps data, graphs, animations and reports can be exported and saved
in the desired folder in the applicable format.

The export icons used in Alastri software:
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@

Export button

Export Single Item/record

Export All ltems/records

B & &

Export button with a dropdown list of available options

Also, for all setup steps in the Setup tab, you can right-click on any task and select the "Export to File"
option, to export settings for an entire setup task.

Setup Task
@ Misc Fields B
@ Drilling Fields
@ Crill Hole Types
@ Mininn Fields

& Run to this
@ su Import frem File
&) Preschedule

The applicable options and export formats are covered in more details in the relevant Export sections for
each application.

Exporting an image/screenshot
Some setup steps and tabs have a button to save a screenshot, which you can also use for exporting.

In addition, the entire project can be imported and exported through the File button located in the upper
left corner of any of the applications.

Auto Save

By default, users are prompted to save their project every thirty minutes. The timeout duration can be
changed in Tools > Auto Save.
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File Help

Sethl

3

Auto Save J
—| +f Append Version to Filename
@ Change Skin 3

|5 <Default>

T

Setup Task

@ Extension Source

If you get a crash, Auto Save means you only lost ~15 minutes work, instead of the last ~4 hours.

Skin Themes

To suit your visual preferences, all the applications from Alastri are available in a variety of colors and

designs.

To change the design theme:

L

Fie [omi] v

Auto Save

Set

| ¥ Append Version to Filename

I@ Configuration Options

l@ Extension Parameters

B Haul Infinity
[

Off

1 minute
5 minutes
10 minutes
15 minutes
30 minutes

1 hour

Click the Tools button located in the top bar of each app.
From its dropdown, select the "Change Skin" option.

An extensive list of available themes opens, including two tabs for bonus and special themes.
Select any theme you like depending on your preferences and wait for its downloading.

8 [ Change skin

& <Default> ~igh

Basic

The Bezier

Office 2019 Colorful
Office 2019 Black
Office 2019 White
Office 2019 Dark

@100 0%

DevExpress Style
DevExpress Dark Style
Office 2016 Colorful
Office 2016 Dark
Office 2016 Black
Office 2013 White
Office 2013 Dark Gray
Office 2013 Light Gray
Office 2010 Blue

3 Office 2010 Black
Office 2010 Silver
Visual Studio 2013 Blue

(== NN

Visual Studio 2013 Dark
Visual Studio 2013 Light
Seven Classic

Visual Studio 2010

Bonus Skins »

Theme Skins »

BEexe0®

6@

N X Xel

™
&

L00O

) Liquid Sky
) London Liquid Sky

s Office 2007 Green
4s Office 2007 Pink

Black

Blue

Caramel

Coffee N
Dark Side

Darkroom

Foggy

Glass Oceans

High Contrast
iMaginary

Lilian

Metropolis
Metropolis Dark
Money Twins
Office 2007 Black
Office 2007 Blue

Office 2007 Silver
Seven

Sharp

Sharp Plus
Stardust

The Asphalt World
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For better clarity of the buttons pressed and options selected, we recommend using skin themes such as

Office 2010 Silver.

In the example below, we can see that:

Select arrow is activated.
Show Mouse Text and Snap

b o

File ' Tools @ Help

“Append Versions to Filename” option has been chosen for saving projects.
Office 2010 Silver theme is currently highlighted and selected.

to Surface/Model buttons are pressed.

Auto Save > ul Infinity
7»/7 Append Version to Filename ktensions Tools Help
_~” Change Skin » I N Basic
: . 7 The Bezier | — )
Haace 49 R = ¢ 8@ (P
— | I Office 2019 Colorful
R Seecoes | 3 Office 2019 Black
MalenATine o | (@ Office 2019 White
e BRI | (3 Office 2019 Dark
Truck KOMB830E_AHS | DevExpress Style
Operating Conditions | | i DevExpress Dark Style
iRl | I3 Office 2016 Colorful
i Souce Destind (= Office 2016 Dark
OpenPitM1\P1\P102... Dumps\Dump! X
NnenPit\M1\P11P 102 CrushersiCR 1 G Office 2016 Black
r] Office 2013 White
Blocks
9 = 1} Office 2013 Dark Gray
== P
= ‘ Office 2013 Light Gray
Name Isolaty X
. | 14 Office 2010 Blue
> |¥| OpenPit
> [¥ Dumps 3 Office 2010 Black
> [¥ Backfils | Office 2010 Silver S =
»q  Visual Studio 2013 BI e = S
e 2] » | 1000000001 OpenPitiM1P2P201\78.
*q VisualStudio2013Dark e || | 1000000002  OpenPitWM1P1P102181.
Visual Studio 2013 Light ‘ | 1000000003 OpenPit\M1\P1\P101\79..
£¢  Seven Classic | 1000000004 OpenPitM1\P2\P201\78..
1000000005 OpenPitM1\P1\P102\31..
| @@ Visual Studio 2010 ‘
Nodes  Segments | Blocks To—— , st Grid  Segments Charts  Truck Times
Theme Skins >

Append Version to Filename

When ticked version number will be appended to the filename.

Tools

Help

Auto Save

v

Append Version to Filename

e

oL

Change Skin
Project Settings
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Press File > Save As to save your project to the desired folder. Name of the project file will be

automatically followed by the number of the currently used version.

™
L]

File Tools Help
Setup | Designer MotReady | ReportMotReady | SolidLab

[ This PC

|_j Network

DI EL T BRR. Quick Start Demo Project_21.2.934) I

Save as type: | Rapid Reserver Files (*.rara)

~ Hide Folders
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